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CHAPTER – 14 Introductions to MS- Excel 

II. SHORT ANSWER QUESTIONS: 

1. What is spreadsheet? 

Ans: A spreadsheet is a tool to organize information in rows and columns. A spreadsheet can 

solve our problems of data handling and long calculations.  

2. Mention two methods to start MS- Excel. 

Ans: Two methods to start MS- Excel are: 

1) Double click on the mouse on MS- Excel icon displayed on the desktop of windows. 

2) Start> All programs> Microsoft office 2010> Microsoft Excel 2010. 

3. What do you mean by cell address? 

Ans: A cell address is a combination of column letter and row number of a cell such as C7 or D2. 

4. Write features of MS- Excel. 

Ans: The features of MS- Excel: 

1) MS- Excel presents the data in a tabular form. 

2) It can do mathematical calculations very easily. 

3) It can present the data in the form of charts. 

4) It can make use of formulas and functions for mathematical calculations. 

5) MS- Excel can be used for data analysis. 

6) It can be used for representing the information in the form of charts. 

5. Explain types of data in MS- Excel. 

Ans: The types of data in MS- Excel are: 

1) Number: Numbers are value that consist of numerals from 0+9 and solve special symbols 

like +, _, %, ^, & etc. 

2) Text: Text data contains letters, numbers, and special characters, words that are used for 

worksheet headings, names and for identifying columns of data. 

3) Formula: A formula involves numbers, values, operators, and cell address for doing 

calculations. 

6. .How can you select a range in MS- Excel? 

1) Ans: Go to Cell A1 

2) Press the F8 key. This anchors the cursor. 

3) Click in cell E10. Excel highlights cell A1 to E10. 

4) Press Esc and click anywhere on the worksheet to clear the highlighting. 

7. You have type something in MS word. You want to copy it in MS- Excel. How will you do 

the works? 

Ans:  1) In MS- Word select the rows and Columns of the table that you want to copy. 

 2) To copy the selections press Ctrl+ C 

 3) In excel worksheet select the upper left corner of the worksheet area where you want to 

paste. 

 4) Press Ctrl+ V 

 



8. What is a Formula? 

Ans: A formula is a mathematical equation such as adding or subtracting two numbers. A 

formula involves numbers, value, operators and cell address for doing calculations. 

9. How can you select all cells in a worksheet? 

Ans: 1) Click the select All button     

2) To select the entire worksheet. You can also press Ctrl+ A key. 

10. How can you select adjacent rows or columns? 

Ans: Drag across the row or column heading or select the first row or columns. Then hold down 

shift while you select the last row or column. 

11. Write steps to close a worksheet? 

Ans: 1) Click file tab. 

2) Click close option from the file menu. 

12. Write a note on formula bar. 

Ans:  Formula Bar is where data or formulas you enter into a worksheet appear for the active 

cell. The Formula Bar can also be used to edit data or formula in the active cell.  

13. How can you enter data in a worksheet? 

Ans:  To enter data in a worksheet, position your cell in the cell that you want to insert the data. 

You can insert the data in a cell by typing from the keyboard. You can use arrow keys for 

movement in other cell, or click the mouse over a particular. 

14. What is the difference between Worksheet and workbook? 

Ans: A spreadsheet is also known by the name of Worksheet. Worksheet is a rectangular sheet 

visible on the screen in which small cells are available. The entire worksheet is very big in size; 

therefore it is not possible to see it altogether on the screen. 

Workbook is a collection of several worksheets. However by default, there are three worksheets 

in the workbook. There are Sheet1, Sheet2 and Sheet3. These sheets can be renamed and also a 

new sheet can be added in the workbook. 

15. What is the number of columns in a worksheet? 

Ans: There is 16384 columns in a worksheet. 

16. .What is the use of & operator? 

Ans: & operator is used to combine the content of cells in a new cell & operator is also called 

concentration operator. 

17. What will be the result of A1* 20%? 

Ans: A1* 20% displayed 20% of the contents of A1. 

18. How can you open an existing workbook? 

Ans: One can open the existing workbook by clicking file tab open option and selecting the 

desired workbook or clicking on the open button present on the quick Access toolbar. If open 

button is not present on the Quick access toolbar, then click open checkbox from the Quick 

Access toolbar. 

19. How can you change the margins before printing? 

Ans: 1) Click on margins tab in the Page Setup dialog box. 

2) Here you can set top left right, button margins. Header and Footer can also be set. 

3) You can also enter data vertically or horizontally on a page. Choose any one by making a 

check. 

 

 

 

 



III. LONG ANSWER QUESTIONS: 

1. Explain main elements of Excel screen. 

Ans: The main elements of Excel screen are: 

1)  The Quick Access Toolbar 

2) The Title bar 

3)  The ribbon  

4) The formula Bar 

5) The status Bar 

6) Name Box 

7) The Worksheet 

8) Active Cell 

9) Column letter 

10) Row Number 

11) Sheet tab 

12) Cell Address 

2. How can you move around the spreadsheet using different keys? 

Ans: 

 

 

 

 

 

 

 

 

 

 

 

3. How can you create and save a workbook? 

Ans: After entering data it becomes necessary to save your work at regular intervals. Whenever a 

file is saved for the first time, MS Excel displays the Save As dialog box.  You can give a 

suitable name to your file. 

1) Click the File tab and choose save. The save as dialog box will appear. 

2) In the Save as dialog box, in the file name box, give a suitable name for your workbook.  

3) Click the save button to save the file in the selected folder. 

4. How can you select two different ranges in a worksheet? 

Ans: A large range of cell: Click the first cell in the range and then hold down shift while you 

click the last cell in the range. Scroll to make the last cell visible. 

All cell on a worksheet: 1) Click the select All button. 2) To select the entire worksheet, you can 

also press Ctrl+ A key. 

5. What is the role of operators in formula? 

Ans: operators are characters that represent an action. Operators tell excel what mathematical 

functions or what logical expression to evaluate. Arithmetic operators are used to perform basic 

mathematical operations such as additions, subtractions or multiplications, combine numbers and 

produce numeric results. 

KEY(S) FUNCTION 

Home key Moves the active cell highlighted to column A without changing rows. 

Ctrl+ Home keys Moves the active cell highlight to cell A1 

Ctrl+ End keys Moves the active cell highlight to the last cell of the spreadsheet containing 

right. 

 Move one column right 

 Move one column left 

 Move one row up 

 Move one row 

Page up Moves the active cell highlight to the first row of the spreadsheet 

Page down Moves the active cell highlight to the next sheet. 



6. How can you select an entire row and column? 

Ans: 1) Click the row or column heading. 

 2) You can also select cells in a rows or columns by selecting the first and the pressing Ctrl+ 

Shift+ Arrow keys (Right arrow or Left arrow for rows, Up arrow or Down arrow for columns). 

7. How can you print a worksheet? 

Ans:  To print a worksheet, choose File tab and select print option and after doing required 

settings, click or print button. 

Three options will display on the Print pane under Settings: 

1) Active Sheets: Print the active sheet or sheets that you selected. 

2) Entire Workbook: Prints the entire workbook, including chart sheets. 

3) Selection: Prints only the range that you selected before. 

  

CHAPTER – 15 Editing workbooks in MS Excel 

II. SHORT ANSWER QUESTIONS: 

1. How can you adjacent two or more adjacent sheets? 

Ans: 1) Click the tap for the first sheet 

2) Then hold down shift while you click the tab for the last sheet that you want to select. 

2. What is formula? 

Ans: A formula is a mathematical equation such as adding or subtracting two numbers. A 

formula involves number values, operator and cell address for doing calculation. 

3. What is the default row height and column width? 

Ans: The default row height is 12.75 points and the default column width is 8.43 characters. 

4. How can you change the height of row by using the mouse? 

Ans: To change the row height of one row, drag the boundary below the row heading until the 

row is the height that you want. 

5. .Explain Auto fills features briefly? 

Ans: An Auto fill feature is used for filling cells with data that follows a pattern or that is based 

on data in other cells. 

6. What is the use of undo command?  

Ans: The use of undo command is that, we can undo an action which has been done by mistake. 

The last action you have performed is cancelled and the deleted content is restored. 

7. .How can you change the font type, size and colour? 

Ans: 1) Select cells whose font style you want to change. 

2) On the Home tab in the font group, select drop down arrow next to font type, size and colour 

button to modify it. 

8. What is the purpose of warp text option? 

Ans: Warp text button on the alignment group is used to fit the text within a cell. 

 

 

 

 

 

 

 

 



III. LONG ANSWER QUESTIONS: 

1. How can you insert rows in a worksheet? 

Ans: 1) To insert a single row, select either the whole row or a cell in the row above which you 

want to insert the new row. 

2) On the Home tab, in the cell group click the arrow next to insert and then click the selected 

rows and then click insert sheet rows. You can also right click the selected rows and then click 

insert. 

2. Write different procedures to select worksheets. 

Ans:  1) A single sheet: 

 Click the sheet tab. 
2) Two or more adjacent sheets: 

 Click the tab for the first sheet. Then hold down shift while you click the tab for the 
last sheet that you want to select. 

3) Two or more none adjacent sheets: 

 Click the tab for the first sheet. Then hold down shift while you click the tab for the 

other sheets that you want to select. 

4) All sheets in a workbook: 

 Clicks select All sheet on the shortcut menu. 

3. How can you move or copy data to another worksheet? 

Ans: In the move or copy dialog box, do one of the following: 

1) To copy the sheet instead of moving them, in the move or copy dialog, select create a 

copy checkbox. 

4. How can you change the width of a column? 

Ans: 1) Select the column or columns that you want to change. 

 2) On the Home tab, in the cell group, click format. 

 3) Under cell size, click column width. 

 4) In the column width box, type the value that you want. 

5. How can you delete cells, rows or columns? 

Ans: 1) Select the cells, rows, or columns that you want to delete. 

 2) On the Home tab, in the cells group, click the arrow next to delete and then do one of the 

following: 

 To Delete selected cell, click Delete cells. 

 To Delete selected row click Sheet rows 

 To Delete selected Columns, Delete Sheet Column. 

6. How can you format the numbers? 

Ans: Number formatting is the most useful feature of Excel. You can format numbers with 

decimal places, currency, date/ time, percentage symbols etc. 

To format the number: 

1) Select range of cells. 

2) On the Home tab, in the numbers group, click Format cells dialog box launcher. 

3) Under number tab, select tab, select the category according to your requirement. 

 

 

 

 



CHAPTER – 16 Functions in MS Excel. 

II. SHORT ANSWER QUESTIONS: 

1. What is a function? 

Ans: A function is a pre-designed calculations entered in a cell to help you analyze or manipulate 

data in a spreadsheet. All you have to do is add the argument and the calculation is automatically 

made for you. 

2. What is an Argument?  

Ans: Argument can be numbers, text, logical values such as TRUE or FALSE, cell references. 

The arguments you designate must produce a valid value for that argument. 

3. .What will be the result of SUM (B2:B4, 16) is B@= 5, B3= -10, B4= 30? 

Ans: (B2:B4,16)  =(B2+ B3+ B4) + B16 

   = {5+ (-10)+ 30} + 16 

   = 29+ 16 

   = 41 

4. What is the result of MAX functions? Give an example? 

Ans: A MAX function is used to find the maximum value in the specified range. 

Eg: C3=8, C4= 50, C5= 81, C6= 78 

=Max (C3:C6) will display the maximum value from C3 TO C6 i.e.: 83 in cell C7 

5. Explain is used to find the maximum value in the specified range. 

Ans: 1) AVERAGE function: This function is used to find the average of numbers in a given 

range.  AVERAGE function ignores empty cells with text values. 

 2) MAX function: This function is used to find the maximum value in the specified range. 

6. What is relative referencing? 

Ans: When cell are referenced on the basis of their position relatives to the cell containing the 

formula, it is called Relative Referencing. 

7. What is the purpose of IF functions? 

Ans: This function returns one value if a condition you specify evaluates to TRUE and another 

value if it evaluates to FALSE. 

Use IF to conduct conditional tests on values and formulas. 

Syntax: IF (text, IF_True, IF_ False) 

8. Write two differences between functions and formula. 

Ans:  

FORMULA FUNCTION 

1. A Formula is a collection of expressions 

which can do calculations when applied to the 

worksheet. 

1. Function is a pre-designed formula which 

is provided by MS Excel. 

2. It consists of cell address, number, 

mathematical operations and letters. 

2. They can do simple as well as complex 

calculations. 

9. Write some example of AVERAGE Functions. 

Ans: C3= 83, C4= 50, C5= 81, C6= 78 

 = AVERAGE= (C3:C6) 

10. Name any three common functions errors? 

Ans:  

1) #VALUE!  -This error occurs when wrong arguments are used in functions or operators. 

2) # NAME?  -This error occurs when wrong formula is referring invalid name, range or text 

string. 

3) #REF -This error occurs when you delete a cell that referred to some other formula. 

 



III. LONG ANSWER QUESTIONS: 

1. What do you mean by mixed referencing? Explain in detail. 

Ans: A combination of relative and absolute referencing is called mixed referencing. 

A cell address is an intersection of a column and a row. It therefore contains two parts; column 

letter and row number. 

The $ before column letter as well as row number makes it absolute cell address. 

The $ before row number or column letter makes it mixed cell address. 

The $ before row number makes the cell as relative cell address. 

2. What is a function? Explain various functions used in MS Excel. 

Ans: A function is a pre-designed calculations entered in a cell to help you analyze or manipulate 

data in a spreadsheet. All you have to do is add the argument and the calculation is automatically 

made for you. 

SUM Functions:  SUM function is used to add all the numbers or the numbers that you specify 

in a row or column. 

AVERAGE Function: This function is used to find the average of numbers in a given range.  

AVERAGE function ignores empty cells with text values. 

MAX Function: This function is used to find the maximum value in the specified range. 

MIN Function:  This function is used to find the minimum value in the specified range. 

COUNT Function: This function is used to count the number of cells containing numeric 

values. 

IF Function: This function returns one value if a condition you specify evaluates to TRUE and 

another value if it evaluates to FALSE. 

3. What is the difference between relative cell referencing and absolute cell referencing? 

Ans: When cell are referenced on the basis of their position relatives to the cell containing the 

formula, it is called Relative Referencing. Whereas, cell referencing in which references do not 

change when a formula is copied to a different cell is called Absolute referencing. 

4. How is referencing different from copying? Explain. 

Ans: The Referencing is different from mere copying. If the formula of E2 cell is copied to E3 

cell, it will be interpreted as=B3+ C3+ D3. All the cells are shifted one cell down. Similarly if the 

formula is copied at E7 cell, it will be interpreted as =B7+ C7+ D7. 

A formula copied from one cell to another, adjust itself according to the position of new cell.  

5. Explain common errors that occur in functions. 

Ans: The common errors that occur in functions are: 

1) #VALUE!  -This error occurs when wrong arguments are used in functions or operators. 

2) # NAME?  -This error occurs when wrong formula is referring invalid name, range or text 

string. 

3) #REF -This error occurs when you delete a cell that referred to some other formula. 

4) ##### - This error occurs when column is not wide enough to fit the value. 

5) # DIV/0 - This error occurs when you attempt to divide a value by zero. 

6) #NUM! - This error occurs in a function that produces a number too large or too small. 

 

 

 

 



CHAPTER – 17 Charts in MS Excel 

II. SHORT ANSWER QUESTIONS: 

1. What is a chart? 

Ans: A chart is a graphical representation of numbers. It is a pictorial representation of data in a 

beautiful form. 

2. What is chart area? 

Ans: Chart area is the total region surrounding the chart. 

3. What are gridlines? 

Ans: Gridlines are those lines that are both horizontal and vertical lines in the plot area. These 

lines are inserted in the charts to identify the values of each data point in the chart easily. 

4. What is pie chart? 

Ans: Pie chart shows proportional size of items which makes up a data series to the sum of items. 

5. Write any three chart types. 

Ans: Three chart types in MS Excel are: 

i. Column chart: This type of chart shows change over a given period of time. 

ii. Bar chart: This type of chart illustrates comparisons among individual’s items. 

iii. Pie chart: This type of chart shows proportional size of items which make up a data series 

to the sum of items. 

6. How can you change the style of chart? 

Ans: 1) Click anywhere in the chart that you want to format by using a predefined chart layout. 

2) This displays the chart tools, adding the design, layout and format tabs. 

3) On the Design tab, in the chart layouts group, click the chart layout that you want to see. 

7. How will you resize a chart? 

Ans: To resize a chart:  

i. Click the chart and then drag the sizing handle to the size that you want. 

ii. On the format tab, in the size group, enter the size in the shape height and shape box.  

8. How can you change embedded chart to separate chart? 

Ans: When you press Alt+ F1, the chart is displayed as an embedded chart, when you press F11, 

the chart is displayed on a separate chart sheet. 

III. LONG ANSWER QUESTIONS: 

1. Explain various components of chart. 

Ans: Various components of charts are: 

1) X Axis  : This is the horizontal axis which is also known as category axis. 

2) Y Axis  : This is the vertical axis which is also known as value axis. 

3) Data series  : Data series a set of values with which a chart is plotted. 

4) Chart area  : The total region surrounding the chart is called chart area. 

5)  Plot area  : The part in which data is plotted is called plot area. 

6) Chart title  : The chart title is written on the top of chart. It helps the user in 

identifying the chart. 

7) Axis title  : These are the titles given to three axes X, Y and Z axes. 

8) Legend  : The portion to the right of the Plot area is Legend 

9) Gridlines  : These lines are the both horizontal and vertical lines in the plot area. 

These lines are inserted in the charts to identify the value of each data point in the chart 

easily. 

10) Data Label  : This is a label which provides additional information about data 

marker. 

 



2. Write steps to add title to a chart. 

Ans: The steps to add title to a chart: 

1) Click anywhere to add the title to a chart which you want to add a title. 

2) On the layout tab, in the labels group click chart title. 

3) In the chart title textbox that appears in the chart, type the text that you want. 

4) To format the text, select it and then click the formatting options that you want on the 

mini toolbar. 

3. How can you display or hide primary axes? 

Ans: To display or hide primary axes: 

1) Click the chart for which you want to display or hide axis. 

2) On the layout tab, in the Axis group click axis and then do one of the following. 

 To display axis, click primary Horizontal Axis display option that you want. 

 To hide axis, click primary Horizontal Axis, primary Vertical Axis or Depth Axis 

and then click none. 

4. How can you create a chart? 

Ans: In order to create a chart: 

1) Open a new or any existing worksheet. 

2) Select the data in the existing worksheet or type new data in a new worksheet. 

3) Select the data range. 

4) On the insert tab, in the charts group, click a chart sub-type that you want to use. 

 

5. Explain types of charts in details? 

Ans: The type of chart in MS excel are as follows: 

1) Column chart: This type of chart shows change over a given period of time. It is useful 

for comparison purpose. 

2) Bar chart : Bar chart illustrates comparisons among individual items.  

3) Line chart : Line chart shows trends in a data at equal intervals. 

4) Pie chart : Pie chart shows proportional size of items which make up a data series to the 

sum of items. A pie chart takes a circular shape.  

5) XY (scatter): This chart shows relationships among numeric values in several data series. 

6) Area chart: This chart displays the trend of the contribution of each value over time or 

categories. 

7) Doughnut: Doughnut chart shows relationship like a pie chart but can contain more than 

one data series. 

8) Radar Chart: Each category has its own value axis generating from one centre point. 

9) Surface Chart: This chart shows trends in values across two dimensions in a continuous 

curve. 

10) Bubble Chart: Bubble chart compares set of 3 values. Like a scatter chart with the third 

value displayed as the size of the bubble marker. 
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